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Conversion Factors and Datums
Multiply By To obtain

inch (in.) 25.4 millimeter (mm)

foot (ft) 0.3048 meter (m)

foot per day (ft/d) 0.3048 meter per day (m/d)

foot squared per day1 (ft2/d) 0.0929 meter squared per day (m2/d)

gallon per minute (gal/min) 0.06308 liter per second (L/sec)

mile (mi) 1.609 kilometer (km)

1Expresses transmissivity. An alternative way of expressing transmissivity is cubic foot per day per 
square foot times foot of aquifer thickness [(ft3/d)ft2] ft. 

Horizontal coordinate information is referenced to the North American Datum of 1927 (NAD 27).  
Vertical coordinate information is referenced to the National Geodetic Vertical Datum of 1929 (NGVD 29). 
Altitude, as used in this report, refers to distance above the vertical datum.  
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Preface 
This report documents a spreadsheet that has been devel-

oped for analyzing time series with an emphasis on estimating 
drawdowns during aquifer tests by removing extraneous water-
level changes at observation wells resulting from barometric 
pressure changes, earth tides, or regional water-level trends.  
The spreadsheet was developed for Microsoft Excel version 
9.0 or higher.  Use of trade names does not constitute endorse-
ment by the U.S. Geological Survey (USGS).  The spreadsheet 
has been tested for accuracy using datasets from different 
aquifer tests and FORTRAN solutions of dry earth tide and 
gravity tide.  If users find or suspect errors, please contact the 
USGS.   

Every effort has been made by the USGS or the United 
States Government to ensure that the spreadsheet is error free.  
Despite our best efforts, the possibility exists that errors exist 
in the spreadsheet.  The distribution of the spreadsheet does 
not constitute any warranty by the USGS, and no responsibil-
ity is assumed by the USGS in connection therewith.  

Abstract 
Drawdowns during aquifer tests can be obscured by baro-

metric pressure changes, earth tides, regional pumping, and 
recharge events in the water-level record.  These stresses can 
create water-level fluctuations that should be removed from 
observed water levels prior to estimating drawdowns.  Simple 
models have been developed for estimating unpumped water 
levels during aquifer tests that are referred to as synthetic 
water levels.  These models sum multiple time series such as 
barometric pressure, tidal potential, and background water 
levels to simulate non-pumping water levels.  The amplitude 
and phase of each time series are adjusted so that synthetic 
water levels match measured water levels during periods unaf-
fected by an aquifer test.  Differences between synthetic and 
measured water levels are minimized with a sum-of-squares 
objective function.  Root-mean-square errors during fitting 
and prediction periods were compared multiple times at four 
geographically diverse sites.  Prediction error equaled fitting 
error when fitting periods were greater than or equal to four 
times prediction periods.  

The proposed drawdown estimation approach has been 
implemented in a spreadsheet application.  Measured time 
series are independent so that collection frequencies can differ 

and sampling times can be asynchronous.  Time series can be 
viewed selectively and magnified easily.  Fitting and predic-
tion periods can be defined graphically or entered directly.  
Synthetic water levels for each observation well are created 
with earth tides, measured time series, moving averages of 
time series, and differences between measured and moving 
averages of time series.  Selected series and fitting param-
eters for synthetic water levels are stored and drawdowns are 
estimated for prediction periods.  Drawdowns can be viewed 
independently and adjusted visually if an anomaly skews 
initial drawdowns away from 0.  The number of observations 
in a drawdown time series can be reduced by averaging across 
user-defined periods.  Raw or reduced drawdown estimates 
can be copied from the spreadsheet application or written to 
tab-delimited ASCII files.  

Introduction
Barometric pressure variations, earth tides, regional 

pumping, and recharge events commonly affect water levels in 
observation wells (Jacob, 1940; Ferris, 1951; Melchior, 1964; 
Gregg, 1966; Bredehoeft, 1967; Clark, 1967).  Water levels 
typically fluctuate daily between 0.1 and 0.4 ft because of 
barometric pressure changes and tides (Merritt, 2004).  Water 
levels can fluctuate more than a foot during a week due to 
large weather systems that change barometric pressure.  Water 
levels fluctuate seasonally more than 30 ft where prevalent 
agricultural pumpage occurs, such as in central Florida.  Indi-
vidual recharge events have caused water levels in unconfined 
aquifers to rise more than 2 ft and decline at rates of 0.1 ft/d 
afterwards (O’Reilly, 1998).  

Hydraulic properties of aquifer systems have been deter-
mined by analyzing periodic water-level fluctuations.  Rock 
compressibility and porosity have been related to barometric 
loading (Jacob, 1940; Rojstaczer and Agnew, 1989).  Specific 
storage has been estimated by analyzing water-level fluctua-
tions that were induced by earth and ocean tides (Bredehoeft, 
1967; Robinson and Bell, 1971; van der Kamp and Gale, 
1983; Hsieh and others, 1988).  Earth-tide, ocean-tide, and 
barometric fluctuations have been analyzed exhaustively to 
estimate lateral hydraulic diffusivity (Jacob, 1940; Ferris, 
1951; van der Kamp, 1972; Jiao and Tang, 1999; Li and Jiao, 
2001; Merritt, 2004).  Pneumatic diffusivity has been esti-
mated by exploiting transient, barometric pressure differences 
between a well in an unconfined aquifer and the surrounding 
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unsaturated zone (Weeks, 1979; Rojstaczer, 1988; Rojstaczer 
and Riley, 1990).  

Pumping-induced drawdowns are analyzed to estimate 
hydraulic properties and are the difference between observed 
water levels and what water levels would have been in the 
absence of pumping.  Periodic water-level fluctuations and 
trends typically can be ignored where drawdowns are great 
and pumping periods are short.  Daily fluctuations of 0.5 
ft will not obscure drawdowns of more than 5 ft.  Regional 
water-level declines of 0.05 ft/d typically will not alter hydrau-
lic property estimates when pumping periods are less than a 
few days.  

Periodic water-level fluctuations can obscure the mea-
surement of interest during aquifer tests and in most other 
hydrologic applications.  Water-level changes other than 
those from planned pumping are considered undesirable 
when analyzing an aquifer test and should be removed prior 
to analysis.  These fluctuations substantially affect drawdown 
estimates where the extraneous water-level changes are of 
equal or greater magnitude.  Tidal water-level fluctuations of 
several feet in coastal areas also complicate the construction of 
potentiometric surfaces (Gregg, 1966).  Errors in water level 
of a foot can reverse apparent flow directions where the range 
of water levels is only a few feet (Erskine, 1991).  

Barometric water-level fluctuations typically are removed 
by relating these periodic fluctuations to nearby air-pressure 
changes with a barometric efficiency (Jacob, 1940; Clark, 
1967; Furbish, 1991).  Barometric efficiency is the ratio of 
change in water level to change in barometric pressure (Ferris 
and others, 1962).  Barometric effects are removed by sub-
tracting air-pressure change times barometric efficiency from 
a measured water level.  Tidal fluctuations also are described 
and removed with tidal efficiencies (Ferris and others, 1962; 
van der Kamp and Gale, 1983).  A tidal efficiency is the ratio 
of change in water level to change in an ocean tide gage or 
theoretical earth tide (Bredehoeft, 1967; Erskine, 1991).  

Regional water-level trends have been extrapolated from 
antecedent data to estimate drawdown during aquifer tests 
(Ferris and others, 1962).  A linear trend can approximate 
regional water-level changes or recovery from previous pump-
ing at an aquifer-test site but has limited utility after a couple 
of days.  Regional pumping and a rainfall event during a 3-day 
aquifer test in Pennsylvania caused water-level changes to be 
poorly predicted by a linear trend that obscured drawdowns of 
less than 1 ft (Risser and Bird, 2003).  

Water-level changes in the absence of pumping have been 
estimated with water levels from individual wells beyond the 
influence of an aquifer test (Kruseman and DeRidder, 1990).  
Water-level changes at an observation well and a background 
well in Volusia County, Florida, were related with double-
mass curves (Rutledge, 1985).   Drawdowns were less than 0.2 
ft and were not successfully differentiated from natural water-
level fluctuations in the surficial aquifer.  Drawdowns also 
were estimated with linear regressions between water-level 
changes at observation wells and a background well (Halford, 
1997).  Drawdowns of 0.2 ft during a 2-day test in northeast-

ern Florida were detected, but drawdown detection was limited 
to 0.1 ft.  

Simple spreadsheet-based models are proposed for 
estimating water-levels unaffected by pumping during aquifer 
tests.  The summation of multiple time series such as baromet-
ric pressure, tidal potential, and background water levels can 
simulate non-pumping water levels.  These simulated water 
levels will be referred to as synthetic water levels.  Synthetic 
water levels are needed because water levels unaffected by 
pumping cannot be measured during an aquifer test.  The 
amplitude and phase of each time series component included 
in the summation are adjusted so that synthetic water levels 
match measured water levels during a non-pumping period.  
The synthetic water-level approach supplants barometric 
efficiency, tidal efficiency, linear trends, and other correction 
methods commonly applied.  

Drawdowns of less than 0.1 ft can be detected with the 
synthetic water-level approach, which greatly expands the 
volume of aquifer investigated by an aquifer test.  The radius 
of investigation in Theis-like aquifers with transmissivities 
greater than 10,000 ft2/d will double at a minimum and can 
increase more than ten times by reducing drawdown detec-
tion limits from 0.5 to 0.05 ft.  Vertical leakances of confining 
units can be estimated more reliably by reducing the limit of 
drawdown detection.  

Purpose and Scope 

The purpose of this report is to document an approach 
for estimating drawdowns with simple water-level models that 
sum multiple time series.  A method for fitting these models to 
measured water-levels by adjusting the amplitude and phase of 
each series is reported.  An approach for reducing drawdown 
measurements by averaging across user-specified intervals is 
reported.  These approaches and methods are implemented 
in a spreadsheet application.  This spreadsheet is compatible 
with Microsoft Excel versions 9.0 or higher and requires basic 
knowledge of Excel.  Use and applicability of this software is 
documented in this report.  The hydrologic concepts and meth-
ods used in the data processing also are described briefly.  
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Water-Level Components
Barometric pressure, tidal potential, background water 

levels, stream stage, and any other time series are potential 
components in a water-level record.  The relevant components 
can be selected where a relation in the water-level record is 
expected.  For example, a relation between barometric pres-
sure and water levels in well sct4 is not obvious (fig. 1), but a 
relation is expected.  A barometric pressure component should 
be included to test if barometric pressure improves a synthetic 
water-level series of well sct4.  

Barometric Effects

Barometric changes cause greater water-level fluctuations 
in deeper, confined aquifers where rock matrix absorbs more 
of the atmospheric load (Merritt, 2004).  Fluctuations increase 
because pressure instantly affects water levels in wells while a 
stiffer rock matrix transfers little of the increased atmospheric 
load to the confined water column.  Atmospherically induced 
water-level fluctuations typically are less than 0.2 ft during a 
day.  Large barometric pressure changes from regional storms 
can cause water-level fluctuations of about 1 ft during a week.  

Barometric changes also measurably affect water levels 
in unconfined aquifers (Weeks, 1979).  Pressure changes do 
not propagate instantaneously through the unsaturated zone 
because air is highly compressible.  The relatively low pneu-
matic diffusivity of the unsaturated zone creates substantial 
lags between atmospheric and water-level changes.  Uncon-
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Figure 1.	 Daily precipitation, ground-water levels, barometric change, and earth tide at Air Force Plant 6, Mari-
etta, Georgia, April 22 to May 28, 2004.
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fined water-level fluctuations can approach the magnitude of 
confined water-level fluctuations as the depth to water exceeds 
500 ft.  

Tidal Effects

Tides result from changes in gravitational forces as the 
relative positions of sun, moon, and earth change.  The diurnal 
rise and fall of ocean levels are the most common manifes-
tation of varying gravitational forces and are referred to as 
ocean tides.  Ocean tides affect ground-water levels through 
direct head changes in an aquifer or as loads applied through 
a confining unit (Merritt, 2004).  Ocean tide effects are better 
approximated with a nearby tidal gage that also incorporates 
wind and coastal geometry effects in addition to direct gravita-
tional forcing.  

Tidal forces also distort the crust of the earth which cre-
ates water-level fluctuations in mid-continent wells (Brede-
hoeft, 1967; Marine, 1975; Hanson and Owen, 1982; Narasim-
han and others, 1984).  Earth tides periodically deform (dilate 
and compress) the skeleton of the aquifer system, changing the 
porosity and causing measurable water-level fluctuations of as 
much as 0.1 ft or more in wells penetrating aquifers with small 
storage coefficients (fig. 1).  Coupling between the mechanical 
deformation and the fluid filling the secondary porosity ampli-
fies water-level response in wells hydraulically connected to 
the secondary-porosity features.  The presence of secondary 
porosity typically renders the formation more compliant to 
imposed stresses depending on orientation of the fractures or 
faults with respect to the principal component directions of the 
imposed stress. The theoretical crustal strain tensors resulting 
from the two principal lunar daily and semidiurnal tides (O

1
 

and M
2
) are largely horizontal and orthogonal to one another.  

Subvertical fractures with azimuths oriented perpendicular to 
the strain tensor for a particular tide tend to amplify the strain 
and thereby the water-level response (Bower, 1983).

Two theoretical earth tides are included as internal func-
tions in the drawdown estimation spreadsheet.  The first earth 
tide function computes the areal strain tide in parts per billion 
(ppb), and the second function computes the gravity tide in 
microgals (µgal) downward normal to the Earth ellipsoid (Har-
rison, 1971).    

Background Water Levels

Recharge events and regional pumping are identifiable 
stresses that typically affect large areas but are not predicted 
easily with independent time series such as barometric change 
and tidal potential.  Recharge events and regional pump-
ing stresses create similar water-level changes in multiple 
wells over areas of many square miles.  Water levels in wells 
sufficiently removed from an aquifer test can simulate these 
regional stresses and any other unidentified stresses.  Water 
levels in these remote wells will be referred to as background 
water levels.  

Background water levels can be more effective correctors 
than independent barometric and tidal time series even where 
only barometric and tidal stresses are significant.  Barometric 
forcing through the unsaturated zone lags behind because of 
the low permeability of unsaturated rock relative to an open 
well (Weeks, 1979).  The complex relation between baromet-
ric pressure and water levels in a well are explained poorly 
with a barometric efficiency where the unsaturated zone is 
thick.  Background water levels from another well of similar 
construction better approximate this relation.  Likewise, rock 
properties and fracture orientation in an aquifer control tidal 
water-level fluctuations as much as dry earth tide.  Water 
levels from background wells can better approximate the rock-
tide interaction than just dry earth tide.  

Moving Averages and Differences

Amplitudes of diurnal water-level fluctuations in wells 
frequently differ from lower frequency changes such as frontal 
barometric changes.  Frequency dependent differences in 
water-level fluctuations exist between wells because of dif-
ferences in well construction and aquifer properties.  Diurnal 
water-level fluctuations will be less where communication 
between well and aquifer is impeded and wellbore storage is 
increased.  Poorly developed wells with large casing diameters 
and short screens damp high frequency water-level fluctua-
tions.  Low transmissivity aquifers with large storage coeffi-
cients also will damp water-level fluctuations.  

Low frequency signals are separated from diurnal water-
level fluctuations with moving averages of the original time 
series in the spreadsheet.  Water levels typically are averaged 
over 12-hour or 24-hour periods, but any averaging periods 
can be specified.  High frequency signals are differences 
between the raw time series and the moving averages.  Three 
time series: raw, moving average, and differences, are avail-
able for each water-level series.  

Drawdown Estimation with Synthetic 
Water Levels

Drawdowns are differences between measured and syn-
thetic water levels that are created for each observation well.  
Multiple time series such as barometric change, earth tide, and 
background water levels are specified as components of a syn-
thetic water-level series.  Synthetic water levels are modified 
by adjusting the amplitude and phase of each component.  The 
synthetic water level at time, t, is

	

		  ∑
=

++−+=
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i
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where:

�    Documentation of a Spreadsheet for Time-Series Analysis and Drawdown Estimation



	 0C 	 is an offset, L,
	 1C 	 is the slope of water-level change, in LT-1, 
	 n 	 is the number of time-series components, 
	 ia   	 is the amplitude multiplier of the ith component, 

in L (units of ith component)-1, 
	 iφ  	 is the phase-shift of the ith component, T, and 
	 )( ii tV φ+  	 is the value of the ith component at time it φ+  

in units of ith component.
Each time series, iV , is a smooth function because values 

are interpolated between consecutive data pairs.  Interpola-
tion allows data to be collected at variable intervals within a 
time series.  This also means collection frequencies can differ 
between time series and do not need to be synchronized (fig. 
2).  

The amplitude and phase of each component are adjusted 
so synthetic water levels match measured water levels during 

periods unaffected by an aquifer test.  These periods will be 
referred to as fitting periods.  A sum-of-squares of differences 
between synthetic and measured water levels is minimized to 
estimate amplitudes and phases.  Root-mean-square (RMS) 
error is reported instead of sum-of-squares so error and the 
range of fluctuation can be compared easily.  

Amplitude and phase estimates typically are non-unique, 
which is not important for drawdown estimation.  Synthetic 
water levels are the important result, not parameter estimates.  
Amplitude estimates remain unique until two or more of the 
components are highly correlated.  Phase estimates are non-
unique regardless of the number of components because many 
local minima exist.  Adjustment of the phase of each compo-
nent is limited to a user-defined range.  Sensitivity should be 
tested with multiple initial phase estimates because synthetic 
water-level estimates frequently can be improved.  

Fitting periods should coincide with non-testing condi-
tions where all stresses other than pumping for an aquifer test 
affect water levels.  Ideally, a fitting period will be immedi-
ately antecedent to an aquifer test.  Differences between an 
antecedent fitting period and an estimation period are com-
pared easily because water-level changes are greatest at the 
beginning of an aquifer test (fig. 3).  A fitting period can occur 
after an aquifer test, but synthetic water-level will not simulate 
measured water levels as well if water levels are still recover-
ing or background conditions have changed.  

Components of the synthetic water-level record are 
selected by trial-and-error.  Time series that mimic the water-
level record to be analyzed should be selected (fig. 4).  Back-
ground water levels frequently best approximate the water 
levels to be analyzed.  Irrelevant components make the fitting 
process take longer but do not degrade the predictive capac-
ity of synthetic water levels.  The amplitude of an irrelevant 
component will approach zero, which causes this component 
to negligibly affect the synthetic water levels.  
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Figure 2.	 Two time series with different collection fre-
quencies and sampling times.
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The significance of components can be tested by sequen-
tially adding each component to the synthetic water-level 
series (fig. 5).  For example, a synthetic water-level series 
for well SM-23-1 is simulated with barometric change, earth 
tide, and water levels in well TR-3 (table 1).  Wells TR-3 and 
SM-23-1 are 15 mi apart and are both open to the same highly 
transmissive carbonate aquifer in southern Nevada.  Baromet-
ric change approximates much of the observed water-level 
fluctuations in well SM-23-1 with an r2 of 0.89 and a RMS 
error of 0.035 ft.  Addition of an earth-tide series marginally 
improves the synthetic water-levels with an r2 of 0.92.  Addi-
tion of the background well TR-3 greatly improves the match 
between measured and synthetic water levels with an r2 greater 
than 0.99 and a RMS error less than 0.01 ft (fig. 5).  

Measured water levels are subtracted from synthetic 
water levels to estimate drawdowns in each observation well.  
The initial difference between measured and synthetic water 
levels at the beginning of an aquifer test is assumed to be zero.  
Drawdowns can be adjusted visually if discrete anomalies 
skew initial drawdowns away from 0.  Adjustment of the mini-
mum drawdown in a series to equal 0 is reasonable if water-
level rises were caused by the “Noordbergum effect” (Verruijt, 
1969; Wolff, 1970).  

The number of observations in a drawdown time series 
can be reduced by averaging across user-defined periods (fig. 
6).  Drawdown and recovery in a well can be defined quite 
well with less than 100 observations.  Large data sets should 
be reduced to ease aquifer-test analysis.  Selective data reduc-
tion also controls the implicit weighting of solutions toward 
greater numbers of observations.  Raw drawdowns are reduced 
by averaging to smooth high frequency water-level fluctua-
tions (fig. 6). 

Nevada Example 
An example was created by adding drawdown and 

recovery from a hypothetical aquifer test in a confined aquifer 
to the time series from well TR-3.  Pumping responses were 
simulated with a Theis (1935) solution with a transmissivity 
of 20,000 ft2/d and a storage coefficient of 0.0005.  Pump-
ing started 5/1/1997 8:00 and a discharge of 100 gal/min was 
maintained over a 48-hour period.  Pumping ceased 5/3/1997 
8:00 and recovery was simulated until residual drawdown was 
less than 0.01 ft (fig. 7).   

0

1

4/17 4/24 5/1

1997

Earth tide

Background well TR-3

Barometer

SM-23-1

Figure 4.	 Barometric change, earth tide, and ground-water levels in wells TR-3 and SM-23-1 in the Amargosa 
Desert, Nevada, April 17 to May 1, 1997.
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Figure 5.	 Improvement of synthetic water level for well SM-23-1, April 17 to May 1, 1997, by sequentially 
analyzing barometric change, earth tide, and water levels in well TR-3.
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Figure 6.	 Example of drawdown filter, sub-periods, and averaging periods.
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Table 1.  Sites with water-level time series that were used to create synthetic water levels

State
USGS site  
identifier

Site name Latitude Longitude
Altitude 

(feet)

Well 
depth 
(feet)

Depth of 
top  

opening 
(feet)

Depth of 
bottom 

opening 
(feet)

Florida 272728081484701 R20AvPk 27°27’28” 81°47’47” 67 1,266 380 1,266
Florida 272714081545901 R31AvPk 27°27’14” 81°54’59” 78 1,152 460 1,152
Florida 271757081493002 R26AvPk 27°17’57” 81°40’39” 75 1,320 580 1,320
Florida 272012081482501 Marshall 27°20’12” 81°48”25” 63 178 137 478
Georgia 335557084312802 rw204 33°55’57” 84°31’29” 1,072 200 28 200
Georgia 335605084312101 Sct4 33°56’57” 84°31’20” 1,009 600 83 600
Georgia 335612084312901 Sct6 33°56’13” 84°31’31” 1,025 575 57 575
Louisiana -- Lake Felicity 29°20’59” 90°24’48” 0 — — —
Louisiana -- Oyster Bayou 29°15’42” 91°05’42” 0 — — —
Lousiana -- Bay Junop 29°12’16” 91°03’56” 0 — — —

Louisiana 07381328
Houma Navigation 

Canal at Dulac
29°23’06” 90°43’47” 0 — — —

Nevada 363213116133800 TR-3 36°32’13” 116°13’38” 2,402 807 620 678

Nevada 363905116005801 SM-23-1 36°39’05” 116°00’58” 3,543 1,338 1,302 1,332



Hypothetical water-level series HYPO-1 and HYPO-5 were 
created with the Theis model at radial distances of 1,000 
and 5,000 ft, respectively, from the pumping well (fig 7). 
Unpumped water levels in wells HYPO-1 and HYPO-5 were 
the measured water levels from well TR-3 after multiplying by 
1.4, adding 53.2 ft, and shifting forward 75 minutes.  Pumping 
affected water levels were created at 2-minute intervals during 
the first 50 hours of the test and at 4-minute intervals during 
the remainder of the recovery period.  Synthetic water levels 
that use well TR-3 will perfectly match measured water levels 
in either HYPO-1 or HYPO-5 because TR-3 is the underlying 
series in these hypothetical records.  

Drawdown and recovery in well HYPO-5 were estimated 
between 5/1/1997 8:00 and 5/5/1997 8:00 (fig. 8).  Syn-
thetic water levels were created for HYPO-5 with barometric 
changes, dry earth tide, and water levels in well SM-23-1.  The 
synthetic water levels matched measured water levels with a 
RMS error of 0.01 ft during the 2-week fitting period prior to 
the aquifer test.  Drawdown and recovery were observed easily 
in the estimated time-series for HYPO-1, which was within 
0.01 ft of the original Theis solution on average.  

Eliminating more than 97 percent of the observations by 
averaging did not alter the interpretation or statistics of the 
estimated drawdown series (fig. 8). The raw drawdown series 
for HYPO-5 contained 2,203 observations during the 4-day 
period of analysis, which was reduced to 65 observations in 
the filtered drawdown series.  Minimum, maximum, average, 
and standard deviation of the differences between a drawdown 

series and the original Theis solution were -0.05, 0.02, -0.01, 
and 0.01 ft, respectively, for both raw and filtered drawdowns.  

The fitting and drawdown estimation processes would be 
repeated for HYPO-1 and any other observation well because 
the fitting coefficients differ between synthetic water-level 
series.  Amplitude multipliers, phase shifts, and offsets are 
the fitting coefficients that are estimated for each synthetic 
water-level series.  These fitting coefficients differ between 
water-level series to approximate each unique water-level 
series and should be unique even if the underlying time-series 
components are the same.    

Drawdown Detection Limits
Drawdown detection limits affect hydraulic property esti-

mates from aquifer tests.  Hydraulic properties such as specific 
yield cannot be estimated when drawdowns are not detected 
in distant observation wells.  The observations are still useful 
because a minimum specific yield can be determined by fitting 
a ground-water flow solution to the minimum detectable draw-
down.  Likewise, a maximum vertical hydraulic conductivity 
for a confining unit also can be determined.  A drawdown 
detection limit typically is related to drawdown prediction 
error which is unknown during an aquifer test.  

Prediction errors were computed and compared to fitting 
errors where local pumping was absent.  RMS errors during 
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Figure 7.	 Water levels in wells HYPO-1, HYPO-5, and modified TR-3 and drawdowns in wells HYPO-1 and 
HYPO-5, April 26 to May 11, 1997.
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fitting and prediction periods were compared at four geo-
graphically diverse sites in Florida, Georgia, Louisiana, and 
Nevada (fig. 9). Multiple synthetic water levels were created 
in a well at each site with fitting periods of 3, 7, 14, 28, and 
56 days.  RMS errors during fitting periods were compared 
to RMS errors during 7-day prediction periods.  Two predic-
tion periods were investigated at each site for eight prediction 
periods in total.  

Synthetic water levels were created with six or more 
time-series components at each of the four sites (fig. 10).  
Many components created many degrees of freedom, which 
allowed for a better match to measured water levels.  Several 
of the components likely were extraneous, but did not compro-
mise the synthetic water-level results.  For example, synthetic 
water levels were fit to measured water levels in well SM-23-1 
between 4/17/1997 and 5/1/1997.  RMS error was 0.0078 ft 
using barometer, earth tide, gravity tide, and background well 
TR-3 as synthetic water-level components.  RMS error was 
reduced to 0.0071 ft by adding two components, a 24-hour 
moving average of water levels in well TR-3 and differences 
between water levels in well TR-3 and the moving averages.  
Results were functionally unchanged and the predictive power 
of the synthetic water levels was not degraded.  
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Figure 8.	 Water levels in well HYPO-5 and Theis, raw, and filtered drawdowns, April 26 to May 11, 1997.
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Figure 9.	 Fitting and prediction error comparison sites.
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Figure 10.	 Measured water levels, synthetic water levels, and water-level components in well SM-23-1, Nevada,  
during a 14-day fitting period and a 7-day prediction period that began May 1, 1997.
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Prediction error was assumed to be related to fitting error 
by a simple multiplier (table 2).  Ratios of prediction-to-fitting 
error decreased to nearly 1 with fitting periods of more than 
two times the prediction periods.  Large ratios of prediction-
to-fitting error occurred when fitting periods were less than or 
equal to prediction periods.  These large ratios resulted from 
small fitting errors and large prediction errors (fig. 11).  

Water-level predictions from shorter fitting periods 
frequently were biased because a longer-term trend was not 
reproduced by the synthetic water levels (fig. 12).  Synthetic 
and measured water levels differed by their respective RMS 
errors at the end of the prediction periods at the sites in Florida 
(fig. 12), Georgia (fig. 12), and Nevada (fig. 10).  The magni-
tude of the errors ranged from 5 to 20 percent of the predicted 
change in water levels.  The greatest relative error occurred 
at the Georgia site where the predicted change in water levels 
was only 0.2 ft.  
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Table 2.  Ratios of prediction-to-fitting errors, prediction periods, water-level ranges, and prediction-error ranges at sites in 
Florida, Georgia, Louisiana, and Nevada 

Site

Prediction error divided by fitting error

Start of 7-day 
prediction 

range

Water-level 
range,  
in feet

Prediction error, in feet
Fitting period

3-day 7-day 14-day 28-day 56-day Minimum Maximum

Florida 9.2 4.9 3.7 1.6 1.0 08/12/2004 1.86 0.08 0.16
Florida 56.8 4.5 1.7 1.0 1.1 11/12/2004 2.30 .28 .92
Georgia 11.3 6.5 1.8 .8 .4 04/24/2004 .21 .01 .03
Georgia 26.8 4.9 1.5 1.1 .9 05/17/2004 .30 .02 .08
Louisiana 5.4 2.2 1.9 1.6 1.3 05/16/2002 2.70 .09 .19
Louisiana 5.6 1.5 1.2 1.0 .9 06/02/2002 1.10 .05 .12
Nevada 2.5 3.9 1.9 1.0 1.0 05/10/1997 .28 .01 .02
Nevada 4.0 2.6 3.0 .9 .4 06/10/1997 .53 .01 .02
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Figure 11.	 Fitting and prediction errors for five synthetic water levels in well sct4 in Georgia, with a 7-day 
prediction period that begins May 27, 2004.
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Figure 12.	 Measured and synthetic water levels at sites sct4 in Georgia, Sister Lake in Louisiana, and R30AvPk in 
Florida during 14-day fitting periods and 7-day prediction periods.
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Instructions for Time-Series Analysis Workbook
Time-series analysis, data filtering, synthetic water-level simulation, and drawdown estimation are performed within an 

Excel workbook, TimeSeries+Drawdown.RV1.0.xls.  Workbook pages are revealed sequentially as needed to analyze time series.  
All four workbook pages remain visible after being used unless the “RESET ALL” button on the TimeSeries page is pressed.  
Pressing the “RESET ALL” button eliminates all user-defined data, removes all series from charts, and hides all worksheets but 
the TimeSeries page.  

The Time-Series Analysis workbook relies on inherent features of Excel 9.0+ and user-defined macros.  The macro security 
level should be set to Medium (fig. 13) because the program 
will not function if the macro security level is set to High 
or Very high.  The program will work with a macro security 
level of Low but this is ill advised.  All macros, including 
malicious viruses, are activated without warning upon open-
ing Excel.  This program also needs access to VBA and the 
“Trust all installed add-ins and templates” option must be 
checked (fig. 13).  

The Time-Series Analysis workbook fits synthetic 
water levels to measured water levels with the SOLVER 
add-in.  The SOLVER is a general optimization routine 
that adjusts cell values to meet a user-specified objective.  
Adjusted cell values, parameters, can be constrained to user-
defined ranges.  Sum-of-squares differences are minimized 
in the Time-Series Analysis workbook.  The SOLVER add-
in is distributed with Excel and users must have this add-in 
installed.  The path to the SOLVER library changes between 
versions of Excel; therefore, references to the SOLVER 
library are specified dynamically and trusted access to VBA 
is needed.  

Input and heading cells have been identified with 
consistent formatting.  Input cells are formatted with a pale 
yellow background and bounded by double lines.  Data 
should be entered by either typing directly or pasting special 
as values.  Help for data input is provided by the comments 
that are tagged in the associated heading cell.  

Cell Formatting in the Time-Series Analysis Workbook

INPUT cells are formatted with a
pale yellow background and
bounded by double lines.  Unused
areas are shaded grey.

HEADING cells are formatted with
a light blue background.
Embedded comments explain the
related input.

Figure 13.	 Example of Excel forms for changing security  
settings. 
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Step-by-Step Instructions
Step-by-step instructions for the TimeSeries+Drawdown spreadsheet also are provided in the appendix.  The step-by-step 

instructions explicitly track each operation used to analyze the Nevada example.  Users are referred specifically to a workbook, 
page, and cell for each operation.  Limited descriptions of the actions are reported.  

TimeSeries Page

All data are entered and stored on the TimeSeries page.  Time-series are entered with multiple responses for a given time 
(fig. 14, columns B:D) or as independent time-response pairs.  Columns of time entries are differentiated from columns of 
measured responses by the “DATE-TIME” label in row 12.  Site name and location specified on the TimeSeries page.  Latitude, 
longitude, and altitude are needed to compute the areal strain and gravity tides (Harrison, 1971).  

Figure 14.	 Example of TimeSeries page with data entered.

Analysis workbook is distributed
with no data and only the
TimeSeries page visible. Arrange
input series in a data-source
workbook as contiguous blocks of
time and water level.
NV_WLsource.xls is the data-source
workbook that is distributed as an
example.

Copy data from the data-source
workbook and Paste Special… to
the analysis workbook.
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Pasting Data into the Time-Series Analysis Workbook



Paste Special as values to preserve
formatting in the analysis
workbook and break links to the
data-source workbook.

Use the pulldowns in cells C2:C3 to
designate the correct hemispheres
for latitude and longitude. Assign
the correct altitude units in cell C4.

Copy the large data block from the
data-source workbook by Selecting
the upper-left cell, Holding the
SHIFT key & Pressing
<ctrl>+<end>. Copy region into
memory.

Activate the analysis workbook.
Paste Special as Values to cell B12.

Date and time entries should be
captioned "DATE-TIME". Date
series headings should start with
text. Short descriptors of time-
series components will be
comprehensible if the first 2
characters are unique.
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Time series can be filtered to reduce dataset size by eliminating less significant data points.  A mea-
sured response is judged necessary if the response changes more than a user-specified amount since the last 
stored response.  Small changes are defined by the smallest non-zero change in each data series to avoid 
specifying units.  A user-specified maximum time between measurements also constrains the amount of 
data to be eliminated.  These specifications are defined through Filter-Explanation-&-Query wizard.  

Initializing and Filtering Time Series 

Press the “Initialize Series” button
after inserting data.

Row 5, the filter row, will change
formatting from column B to the
right.

Cells will change from gray to light
yellow.

The Filter-Explanation-&-Query
wizard will appear. Change filter
criteria in row 5 of the TimeSeries
worksheet.

If desired, reduce data set based on
time and measurement resolution.
Change all settings before pressing
the FILTER button.
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As much as a 30-minute gap can
exist between filtered entries in this
example.
Default is 30 minutes.

Data changes less than the filter
value are considered insignificant
and will be eliminated if the time
between entries is less than the
maximum time that was specified
in the DATE-TIME column.

Choices are 1, 2, 4, 8, and 16 times
the minimum, non-zero change
between entries.

Revise all entries in row 5 before
filtering the data set.

MAINTAIN BACK-UPS

Raw data are eliminated
permanently and replaced by
filtered data!!!

Maximum time between filtered
entries is assigned in DATE-TIME
columns.
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Pressing the “Initialize Series”
button on the TimeSeries
worksheet also causes the SHOW
worksheet to be revealed.

SHOW Page

Time-series data are viewed on the SHOW page, which was revealed after pressing the “Initialize Series” button on the 
TimeSeries page.  Time-series data that could improve synthetic water-level simulation can be identified by inspecting hydro-
graphs.  Periods before an aquifer test are best for fitting synthetic water levels to measured water levels.  

Viewing Time Series 

Time series are viewed on the
SHOW worksheet. Periods of
record can be magnified.
FITTING, ESTIMATION, and
FEEL GOOD periods can be
defined graphically.

Magnifier Window
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Different series names can be
selected from a pull-down menu in
cells B6:B17.

Check box in column A to display
on secondary axis.

Check box in column B to display a
time series.
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Series color will match the color of
the cell background which can be
changed by selecting a cell and
changing the pattern color.

Activate the FORMAT CELLS
panel with Format>Cells  and
select the PATTERNS tab.

Viewing any series on the SHOW
worksheet also causes the
DETREND worksheet to be
revealed.

Time series are plotted on two charts so that selected records can be viewed at magnified scales.  
Height and width of magnifier window are adjusted graphically in the upper chart.  Magnified area is 
viewed by sliding the vertical and horizontal scrollbars that bracket	 the lower window.  Scrollbar sensitiv-
ity is controlled by minimum and maximum extents that are specified in cells D2:E3.   
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Magnifying Selected Periods of Time Series 

Move vertically to change height of
magnifier window which is
reported in cell B2.

Move horizontally to change width
of magnifier window which is
reported in cell B1.

Adjust Magnifier Window

A cross-arrow will appear with 2
clicks (not a double-click) on either
the upper-right or lower-left
handles.
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Minimum (E2) and maximum (E3)
values define the limits of the
vertical scrollbar. Range frequently
is not initialized well when
amplitudes of series differ greatly.

Enter reasonable minimum (E2)
and maximum (E3) values of the Y-
axis to reduce sensitivity of the
vertical scrollbar.

Color of cells shifts from yellow to
orange while scrollbar is selected.

Minimum (D2) and maximum (D3)
times define the limits of the
horizontal scrollbar.

Color of cells shifts from yellow to
orange while scrollbar is selected.

Fitting, estimation, and feel-good periods can be defined graphically from the SHOW page.  Define the minimum 
and maximum times of a period with the magnifier window.  Press the gray button in cell G2 to define the beginning and 
ending of a period.  The fitting, estimation, and feel-good periods are defined in cells F27:F28, G27:G28, and H27:H28, 
respectively, on the DETREND page.  Estimation periods for estimating drawdowns should be defined by typing directly 
into cells G27:G28 on the DETREND page.  
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Graphically Defining Fitting, Estimation, and Feel-Good Periods 

Synthetic time series are
simulated and matched to
measured time series in the
FITTING period.

The Command button will force
minimum and maximum times of
a selected period to the extents of
the magnifier window.

The Fitting period and width of
the magnifier window will
coincide after pushing the
command button and accepting
the message choice.
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DETREND Page

Synthetic water levels are simulated and drawdowns are estimated from the DETREND page.  Synthetic water levels 
can be simulated from a maximum of 24 time series, cells F33:AC33, plus a linear trend, cell D32.  Raw, moving average, and 
differences between raw and moving averages of each user-defined series are available.  Earth-tide and gravity-tide series are 
computed at 30-minute intervals from internal functions.  

The estimation period in the Nevada example is from 5/1/1997 8:00 to 5/5/1997 8:00. 

Major Features of the DETREND Page 

Drawdowns or other anomalous
responses are estimated by
differencing synthetic and
measured time series during the
ESTIMATION period. Synthetic
and measured time series are
viewed for any arbitrary period in
the FEEL GOOD period.

Synthetic time series are simulated
and drawdowns are estimated from
the DETREND worksheet.
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Begin is the first time sampled,
row 27. End is the last time
sampled, row 28. Interval defines
the frequency of sub-sampling,
row 29. All available data pairs
will be sampled if an interval of
00:00 is specified.

Phase increment is the number of
subdivisions between the
minimum and maximum phase-
limit.
Moving averages of original series
are averaged over the user-
specified period.

PRIMARY SELECTIONS
Assign phase-shift and moving
average criteria, cells (B26:B28)
Refine time periods and sub-
sampling, cells (F27:H29).
Select series to analyze, (B32).
Select components of synthetic
time series, cells (F33:AC33).
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Select components of synthetic
time series, cells (F33:AC33).
Raw, moving average, and
differences between raw and
moving averages of each series are
available in addition to earth-tide
and gravity tide components.
Checked cells are estimated.

Time series to be analyzed, cell
(B32), which is selected from a
list.

AQUIFER TESTS
Beginning of ESTIMATION,
column G, are when pumping
begins. End of ESTIMATION
either is when pumping or
recovery ceases.
Both values should be typed
directly.
The estimation period in the
Nevada example is from 5/1/1997
8:00 to 5/5/1997 8:00.

Synthetic time-series components are interpolated linearly from the user-supplied time series 
because fitting works when the functions are continuous.  Subsets of the specified time series 
and their derivatives are copied to a hidden worksheet, TS3, when a new synthetic time series is 
loaded.  Subsets are used because applying look-up functions to limited periods is faster.  

Synthetic time series are estimated by fitting to measured values when an anomalous stress, 
such as pumping, is not present.  Each component of a synthetic time series is modified with a 
multiplier that changes amplitude, row 32, and a constant that shifts phase, row 31.  Amplitude 
and phase shift estimates typically are non-unique.  This is not a limitation because synthetic time 
series are the result of interest, not the parameter estimates.  
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Loading and Fitting Synthetic Series 

Synthetic, measured, and difference
time series appear for the FITTING
period after loading.
Differences will be great if
initialized at load.

Cell content is forced into
agreement after loading a time
series and components. All input
cells will revert to pale yellow
backgrounds with black text.

Phase shifts and multipliers will be
initialized if option at cell C29 is
checked.
Cells that are not in agreement with
the loaded time series and
components are displayed with red
backgrounds and bright yellow text.
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Drawdown estimates are differences between measured and synthetic water levels.  The initial differ-
ence between measured and synthetic water levels at the beginning of a test is eliminated by subtracting the 
initial difference from all synthetic water levels.  

Viewing Components and Estimating Drawdowns  

Reduction of RMS error can be
viewed in the lower left corner of
the Excel window as the Solver
minimizes the differences.

Press the FIT button to minimize
the differences.
Follow instructions in SOLVER
WARNING for the first push of the
FIT button. Solver panel must be
activated and dismissed manually,
once.

View individual components by
changing selection in cell E33.
Phase shift of selected component
can be adjusted with slider in cell
E33.

Test effect of incremental phase
change with the spin buttons in
cells F30:AC30.
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Synthetic, measured, and difference
time series are viewed for any
arbitrary period when FEEL GOOD
is selected and the series are
LOADED.

Time series and components for the
estimation period will be created
after pressing the LOAD button.

Estimating any drawdown or
detrended time-series on the
DETREND worksheet also causes
the RESULTS worksheet to be
revealed.

RESULTS Page

Drawdown estimates are viewed and exported to ASCII files from the RESULTS page.  Drawdowns in each well can be 
exported to individual, tab-delimited ASCII files, which can be used by software used to calculate hydraulic properties.  A well 
name, starting date, and starting time are written to the header of each drawdown file.  Measurement date and time are written 
with each elapsed time-drawdown pair to help trace spurious responses.  

Drawdown responses can be reduced further by averaging during sub-periods with an auxiliary program that is called from 
the FILTER DRAWDOWN command in cell A33.  This program replaces drawdown estimates with a reduced set of time-aver-
aged values.  Drawdown and recovery components are divided into three sub-periods each for a total of six sub-periods.  Draw-
downs are averaged over user-specified intervals for each sub-period.  

Drawdown and recovery responses in a well should be defined with less than 100 observations.  A drawdown response of 
1,000 observations can be represented equally well with fewer than 100 observations.  Solution time is directly proportional to 
the number of observations when using an analytical model.  Furthermore, plotted results become unintelligible with too many 
observations, regardless of the solution technique.  
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These drawdown estimates are analyzed by copying directly from the spreadsheet application or writing the results to tab-
delimited ASCII files.  

Viewing, Filtering, and Exporting Drawdowns  

Drawdowns are viewed on the
RESULTS worksheet.
Results can be written to tab-
delimited, ASCII files or copied
directly from the RESULTS
worksheet.

FILTER DRAWDOWN
Replaces drawdown estimates with
a reduced set of time-averaged
values.  Drawdown and recovery
components are divided into 3 sub-
periods each for a total of 6 sub-
periods.  Drawdowns are averaged
over user-specified intervals for
each sub-period.

OFFSET ADJUSTMENT
Drawdowns can be adjusted with
the spin button so the initial
drawdowns are 0. Check the series
to adjust before pressing the spin
button. Slide a drawdown series up
until the minimum drawdown in the
series equals 0 if "Noordbergum
effect" caused negative drawdowns.
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Drawdown estimates are exported
by copying directly from the
spreadsheet or writing the results to
tab-delimited, ASCII files.

Pump Off time should be typed
directly.
The pump-off time in the Nevada
example is 5/3/1997 8:00.

Limitations
The TimeSeries+Drawdown spreadsheet was developed 

for Microsoft Excel which limits the program.  Individual 
time series are limited to about 65,000 data pairs and should 
be reduced to less than 32,000 data pairs after filtering.  Time 
series with more than 32,000 data pairs will be truncated in 
charts because Excel limits each series in a graph to 32,000 
pairs.  
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Appendix 

Step-by-Step Instructions for Nevada Example
The spreadsheets TimeSeries+Drawdown.V1.0.xls, NV_WLsource.xls, and FilterTEMPLATE.AQUSGS are referred in the step-by-step instructions.  

TimeSeries+Drawdown.V1.0.xls and NV_WLsource.xls are opened directly as conventional Excel files.  FilterTEMPLATE.AQUSGS is a specialized tool for filtering draw-
down estimates that is called from the TimeSeries+Drawdown.V1.0.xls workbook.  Users should not open FilterTEMPLATE.AQUSGS directly. 

Instructions are provided in a five column table.  The first three columns identify the workbook, page, and cell that should be selected for a specific step.  User actions, 
such as copy, paste, slide, or press, are specified in the fourth column.  Limited descriptions of spreadsheet responses to the user actions are reported in column 5.  Row col-
ors alternately are changed between white and yellow to indicate a change between pages or workbooks.  

Step-by-Step Instructions for Nevada Example—Continued

WORKBOOK Page Cell Action Description

NV_WLsource.xls NV B1:B4 Edit > Copy Range Define name and location of site

TimeSeries+Drawdown.V1.0.xls TimeSeries B1 Edit > Paste Special ... Values

NV_WLsource.xls NV A6:I20015 Edit > Copy Range Define time-series to be analyzed

TimeSeries+Drawdown.V1.0.xls TimeSeries B12 Edit > Paste Special ... Values

TimeSeries+Drawdown.V1.0.xls TimeSeries A14 Press “Initialize Series” button Catalog available time series, initialize time-series 
filtering process, and reveal the following page, 
SHOW

TimeSeries+Drawdown.V1.0.xls TimeSeries B5 Change settings in Row 5 of the sheet TimeSeries Follow instructions in the wizard.  Change settings on 
the sheet TimeSeries

TimeSeries+Drawdown.V1.0.xls TimeSeries Press “FILTER” button on the “FILTER EXPLANATION & 
QUERY” form

TimeSeries+Drawdown.V1.0.xls TimeSeries Activate “SHOW” page 

TimeSeries+Drawdown.V1.0.xls SHOW B11 Check box and activate “TR-3” hydrograph Plot hydrograph record

TimeSeries+Drawdown.V1.0.xls SHOW B9 Check box and activate “HYPO-1” hydrograph Plot hydrograph record

TimeSeries+Drawdown.V1.0.xls SHOW Grab upper, right handle of magnifier window in the upper plot.  
Change from (7/28/97 07:59:57, 6.10)  to ~(3/18/97, -19.4).

Adjust magnifier window to view water levels over a 
three week period.

TimeSeries+Drawdown.V1.0.xls SHOW B1 Magnifier window should be about 20 days wide

TimeSeries+Drawdown.V1.0.xls SHOW B2 Magnifier window should be about 1 ft high

TimeSeries+Drawdown.V1.0.xls SHOW E2 Change cell E2 to -1

TimeSeries+Drawdown.V1.0.xls SHOW E3 Change cell E3 to +1

TimeSeries+Drawdown.V1.0.xls SHOW B23 Move slider on vertical slide bar.  Click again if cells E2:E3 
remain orange.  

Magnify periods of record graphically.

Appendix   3


5



36  


Docum
entation of a Spreadsheet for Tim

e-Series Analysis and Draw
dow

n Estim
ation

Step-by-Step Instructions for Nevada Example—Continued

WORKBOOK Page Cell Action Description

TimeSeries+Drawdown.V1.0.xls SHOW C22 Move slider on horizontal slide bar.  Click again if cells D2:D3 
remain orange.  

TimeSeries+Drawdown.V1.0.xls SHOW F22 Upper, right handle of magnifier window should be about 
4/30/97 after adjusting the slider bar

TimeSeries+Drawdown.V1.0.xls SHOW H1 Change to the FITTING selection

TimeSeries+Drawdown.V1.0.xls SHOW G2 Press “FITTING PERIOD” button Define a “FITTING PERIOD” graphically.

TimeSeries+Drawdown.V1.0.xls SHOW B1 Adjust magnifier window in upper plot to be about 4-d wide.

TimeSeries+Drawdown.V1.0.xls SHOW Move slider on horizontal slide bar so left side of magnifier 
window is near 5/1/97 8:00 AM

TimeSeries+Drawdown.V1.0.xls SHOW H1 Change to the ESTIMATION selection

TimeSeries+Drawdown.V1.0.xls SHOW I1 Select an unused cell to force selection button to change 

TimeSeries+Drawdown.V1.0.xls SHOW G2 Press “ESTIMATION PERIOD” button Define an “ESTIMATION PERIOD” graphically 
which is not a good idea for aquifer test analyses.

TimeSeries+Drawdown.V1.0.xls SHOW B1 Adjust magnifier window in upper plot to be about 40-d wide.

TimeSeries+Drawdown.V1.0.xls SHOW Move slider on horizontal slide bar so left side of magnifier 
window is near 4/13/97

TimeSeries+Drawdown.V1.0.xls SHOW H1 Change to the FEEL GOOD selection

TimeSeries+Drawdown.V1.0.xls SHOW I1 Select an unused cell to force selection button to change 

TimeSeries+Drawdown.V1.0.xls SHOW G2 Press “FEEL GOOD” button Graphically define a period for viewing both fitting 
and estimation periods simultaneously.

TimeSeries+Drawdown.V1.0.xls SHOW Activate “DETREND” page 

TimeSeries+Drawdown.V1.0.xls DETREND G27 Change cell G27 to 5/1/97 8:00 Specify beginning of aquifer test

TimeSeries+Drawdown.V1.0.xls DETREND G28 Change cell G28 to 5/5/97 8:00 Specify end of recovery period to be analyzed.  End of 
aquifer test is specified in cell A40 on the RE-
SULTS page.

TimeSeries+Drawdown.V1.0.xls DETREND F29 Change cell F29 to 2 hours

TimeSeries+Drawdown.V1.0.xls DETREND G29 Change cell G29 to 0 hours

TimeSeries+Drawdown.V1.0.xls DETREND H29 Change cell H29 to 4 hours

TimeSeries+Drawdown.V1.0.xls DETREND F26 Select the “FITTING” radio button in cell F26 

TimeSeries+Drawdown.V1.0.xls DETREND B32 Select cell B32 and change to HYPO-1 Define components of the synthetic water levels.

TimeSeries+Drawdown.V1.0.xls DETREND F33 Select cell F33 and change to BARO_SM23{ Raw}

TimeSeries+Drawdown.V1.0.xls DETREND G33 Select cell G33 and change to EarthTide

TimeSeries+Drawdown.V1.0.xls DETREND H33 Select cell H33 and change to GravityTide



Step-by-Step Instructions for Nevada Example—Continued

WORKBOOK Page Cell Action Description

TimeSeries+Drawdown.V1.0.xls DETREND I33 Select cell I33 and change to SM-23-1{ Raw}

TimeSeries+Drawdown.V1.0.xls DETREND J33 Select cell J33 and change to SM-23-1{Differ}

TimeSeries+Drawdown.V1.0.xls DETREND K33 Select cell K33 and change to SM-23-1{MovAvg}

TimeSeries+Drawdown.V1.0.xls DETREND E26 Press “LOAD” button Creates equations for each time-series component that 
was selected.  These equations are limited to the 
fitting period plus the maximum phase shift.  

TimeSeries+Drawdown.V1.0.xls DETREND C31 Press “FIT” button Initiates SOLVER

TimeSeries+Drawdown.V1.0.xls DETREND Dismiss SOLVER warning. Call SOLVER and dismiss.  SOLV-
ER is called from Tools>Solver

TimeSeries+Drawdown.V1.0.xls DETREND C31 Press “FIT” button Initiates SOLVER

TimeSeries+Drawdown.V1.0.xls DETREND G26 Select the “ESTIMATION” radio button in cell G26 Creates equations for each time-series component that 
was selected.  These equations are limited to the 
estimation period plus the maximum phase shift.  
Drawdowns also are estimated and written to the 
RESULTS page.

TimeSeries+Drawdown.V1.0.xls DETREND B32 Select cell B32 and change to HYPO-5 Changes site to analyze.

TimeSeries+Drawdown.V1.0.xls DETREND F26 Select the “FITTING” radio button in cell F26 

TimeSeries+Drawdown.V1.0.xls DETREND E26 Press “LOAD” button Creates equations for each time-series component that 
was selected.  These equations are limited to the 
fitting period plus the maximum phase shift.  

TimeSeries+Drawdown.V1.0.xls DETREND C31 Press “FIT” button Initiates SOLVER

TimeSeries+Drawdown.V1.0.xls DETREND G26 Select the “ESTIMATION” radio button in cell G26 Creates equations for each time-series component that 
was selected.  These equations are limited to the 
estimation period plus the maximum phase shift.  
Drawdowns also are estimated and written to the 
RESULTS page.

TimeSeries+Drawdown.V1.0.xls DETREND Activate “RESULTS” page 

TimeSeries+Drawdown.V1.0.xls RESULTS A29 Press “SHOW ALL” to see drawdowns

TimeSeries+Drawdown.V1.0.xls RESULTS A40 Change cell A40 to 5/3/97 8:00AM.  Pumping time in cell A41 
should read 48:00 hr:min

Specify when pumping ceased for the aquifer test.

TimeSeries+Drawdown.V1.0.xls RESULTS A31 Toggle radio button to Log time

TimeSeries+Drawdown.V1.0.xls RESULTS A32 Toggle radio button to Cartesian time

TimeSeries+Drawdown.V1.0.xls RESULTS A33 Press “FILTER DRAWDOWN” button.  Transfers drawdown estimates to another spreadsheet 
for reducing drawdowns by averaging over user-
specified intervals.
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Step-by-Step Instructions for Nevada Example—Continued

WORKBOOK Page Cell Action Description

FilterTEMPLATE.AQUSGS SEE F26 Change from 20 to 10

FilterTEMPLATE.AQUSGS SEE F27 Change from 20 to 30

FilterTEMPLATE.AQUSGS SEE F28 Change from 20 to 30

FilterTEMPLATE.AQUSGS SEE F29 Change from 10 to 0

FilterTEMPLATE.AQUSGS SEE F30 Change from 10 to 15

FilterTEMPLATE.AQUSGS SEE I25 Check “Logarithmic Axis” 

FilterTEMPLATE.AQUSGS SEE C26 Adjust spin button until End Time in cell E26 is 0d 03:09:00

FilterTEMPLATE.AQUSGS SEE C27 Adjust spin button until End Time in cell E27 is 0d 23:59:00

FilterTEMPLATE.AQUSGS SEE I25 Check “Show recovery after pump off”

FilterTEMPLATE.AQUSGS SEE C29 Adjust spin button until End Time in cell E29 is 2d 00:27:00

FilterTEMPLATE.AQUSGS SEE C30 Adjust spin button until End Time in cell E30 is 2d 14:30:29

FilterTEMPLATE.AQUSGS SEE I25 Uncheck “Show recovery after pump off”

FilterTEMPLATE.AQUSGS SEE I25 Uncheck “Logarithmic Axis” 

FilterTEMPLATE.AQUSGS SEE I26 Press “Filter Drawdowns” Drawdowns are averaged across equally spaced inter-
vals in each sub-period.

FilterTEMPLATE.AQUSGS SEE I25 Check “Logarithmic Axis” 

FilterTEMPLATE.AQUSGS SEE I26 Press “Filter Drawdowns” Drawdowns are averaged across log-equally spaced 
intervals in each sub-period.

FilterTEMPLATE.AQUSGS SEE I25 Uncheck “Logarithmic Axis” 

FilterTEMPLATE.AQUSGS SEE I26 Press “Filter Drawdowns” Drawdowns are averaged across equally spaced inter-
vals in each sub-period.

FilterTEMPLATE.AQUSGS SEE D32 Select “HYPO-5” from pulldown menu View filtered and unfiltered drawdowns in well 
HYPO-5

FilterTEMPLATE.AQUSGS SEE D32 Select “HYPO-1” from pulldown menu View filtered and unfiltered drawdowns in well 
HYPO-1

FilterTEMPLATE.AQUSGS SEE I28 Press “Return Filtered Drawdowns” Unfiltered drawdowns on the RESULTS page in the 
TimeSeries+Drawdown.V1.0.xls workbook are 
cleared and replaced with the filtered drawdowns. 

TimeSeries+Drawdown.V1.0.xls RESULTS A29 Press “SHOW ALL” 1-2 times until drawdowns are visible

TimeSeries+Drawdown.V1.0.xls RESULTS A34 Press “WRITE ASCII FILES”   The files “Ash Meadows_HYPO-1.txt” and “Ash 
Meadows_HYPO-5.txt” will be created.
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